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About Hyper-V Management Suite  
________________________________________ 

Hyper-V Management Suite is a powerful solution for auditing and managing virtual machines across your 

entire Windows network. With the Hyper-V Reports Module you can perform a complete scan for all 

installed VMs in your network. You can perform an automated inventory of VMs and their configuration 

at regular intervals and keep a constant watch on the health of your Hyper-V Servers. The solution 

provides a variety of audit reports that are simple, elegant and highly customizable for System 

Administrators, IT infrastructure Managers and Systems Audit personnel to use and act on. 

 

Hyper-V Management Suite has been architected using the latest Microsoft .NET technology, bringing you 

the best-in-breed reporting solution for your entire Hyper-V Servers. Hyper-V Management Suite is highly 

optimized for performance (using native Windows API calls wherever appropriate), resulting in fast data 

collection of deeply embedded configuration data. Imagine scanning your vast network of Hyper-V servers 

without having to wait forever to see your reports! You can create data subsets for your network using 

our powerful scan options and meaningfully segment your entire network for data collection and 

reporting. 
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System Requirements 
________________________________________ 

For the computer running Hyper-V Management Suite 

Processor Intel Pentium processor 

Disk space & Memory 512 MB RAM and minimum of 20 MB of free disk 
space 

Operating Systems Windows 8.1 / Windows 8 / Windows 7 / Windows 
Server 2012 R2 / Windows Server 2012 / Windows 
Server 2008 R2 / Windows Server 2008 / Windows 
Server 2003 with .NET Framework 4.0 or higher 
with the latest service packs 

Database Microsoft SQL Server 2012 (Enterprise / Standard 
/ Developer / Express edition) or Microsoft SQL 
Server 2008 (Enterprise / Standard / Developer / 
Express edition) or Microsoft SQL Server 2005 
(Enterprise / Standard / Developer / Express 
edition) running in local / remote computer with 
latest Service Pack 

Software MDAC v2.5/2.6/2.8 

  

 

For the Hyper-V Servers reported by Hyper-V Management Suite 

 

Microsoft Hyper-V Server 2012 R2 / Microsoft Hyper-V Server 2012 /Microsoft Hyper-V Server 2008 R2 

with Microsoft Windows Management Instrumentation Service enabled. 

 

  

http://msdn.microsoft.com/data/downloads/default.aspx
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How to purchase?  
________________________________________ 

You can purchase Hyper-V Management Suite online from our website http://www.vyapin.com/. Please 

contact our Sales department at sales@vyapin.com for sales and price related queries. 

 

 

  

http://www.vyapin.com/
mailto:sales@vyapin.com
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How to activate the software?  
________________________________________ 

Once you purchase the software online or through any one of our resellers, you will receive a sale 

notification through e-mail from our sales department. We will send you an e-mail with the necessary 

instructions to activate the software.  

In case you do not receive an e-mail from our sales team after you purchase the software, please send the 

following information to our sales department at sales@vyapin.com with the sales order number: 

 Company Name : End-user Company Name 

 Location  : City & Country for the Company Name given above 

Please allow 12 to 24 hours from the time of purchase for our sales department to process your orders. 

  

 

Image 1 - Activate screen 

Perform the following steps to activate the software: 

1. Download evaluation/trial copy of software from the respective product page available in our 

website at http://www.vyapin.com/ 

2. Install the software on the desired computer. 

3. You will receive a license key through e-mail as soon as the purchase process is complete. 

4. Click 'Activate' in File -> About -> Activate menu to see the Activate dialog (as shown in Image 1). 

5. Copy the license key sent to you through email and paste it in the 'License Key' textbox. For help 

on how to copy the license key, click 'Click here to see how to copy and paste the license key' link 

in the Activate dialog (as shown in Image 2). 
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Image 2 - How to copy license key screen 
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Technical support 
________________________________________ 

Hyper-V Management Suite Frequently Asked Questions (FAQ) section is available online at our website 

http://www.vyapin.com. 

Please direct all technical support questions to support@vyapin.com. Include the following information 

to expedite a response:  

a) Include the version of the product you are using. 

b) If the problem is associated with installation, include the steps that led to the problem. 

c) If the problem is associated with usage, please state the series of steps you performed. 

d) Include the version of the OS, info about any service packs or hot-fixes and local language of the OS 

installed.  

e) Attach the Error Log File available in the common application data path of Hyper-V Management Suite 

(e.g., <Application Data Folder> \ Hyper-V Management Suite\HyperVSuiteErrorLog.Log). 

Note:  

<Application Data Folder> is the common area where Hyper-V Management Suite settings will be stored 

in the machine running Hyper-V Management Suite. The <Application Data Folder> can be found from the 

File -> About screen. The default path of <Application Data Folder> is as follows:  

Windows 7, Windows 8, Windows 8.1, Windows 2008, Windows Server 2012, Windows Server 2012 R2  - 

C:\Users\Public\Documents  

  

 

 

 

 

 

 

 

 

http://www.vyapin.com/
mailto:support@vyapin.com
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Getting Started  
________________________________________ 

Configuration Settings 

Database Settings 

Configuring Computer Enumeration 

Configuring Domain Credentials 

Add a domain 

Edit a domain 

Delete a domain 

Add domains from forest 

Configure SMTP Server 

User connection profiles 
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Configuration Settings 
________________________________________ 

Database Settings 

Computer Enumeration 

Configuring Domain Credentials 

Add a domain 

Edit a domain 

Delete a domain 

Add domains from forest 

Configure SMTP Server 

User connection profiles  
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Database Settings 
________________________________________ 

Hyper-V Management Suite may be configured to use either MS-Access MDB or SQL Server database for 

its data storage to generate reports. If you choose SQL server Hyper-V Management Suite requires an SQL 

Server running SQL Server 2005 / 2008 / 2012 (Enterprise / Standard / Express editions) to connect and 

create a new application database. Hyper-V Management Suite will connect to the specified SQL Server 

based on authentication mode and user credentials to manage its own application database. 

You can access the Database settings by clicking Configuration -> Configuration Settings tab in the Hyper-

V Management Suite main application window and choose Database settings, as shown below 
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User Authentication  

To connect to SQL Server, Hyper-V Management Suite uses the relevant user accounts based on the 

authentication mode as listed below:  

A. Windows Authentication 

In this method, Hyper-V Management Suite uses the currently logged on user account while running 

reports  

B. SQL Authentication 

In this method, Hyper-V Management Suite uses the specified SQL user account and password while 

running reports. Hyper-V Management Suite stores the SQL user name and password as a user profile in 

'Stored User Names and Passwords' applet for its usage.   

Read User Connection Profiles for more details. 

Note: Hyper-V Management Suite expects the user account to have sufficient privileges to create, add to 

and delete database in the SQL server. 

Database creation  

Hyper-V Management Suite creates databases in SQL Server based on the following database options 

(whichever is selected) as outlined below:  

1. Use a single central database for all instances of the application  

A new database will be created in the SQL server by the name Hyper-VManagementSuite. Inside 

the Hyper-VManagementSuite database, separate tables will be created for each installation of 

Hyper-V Management Suite. The table names will be prefixed with the computer name that is 

running Hyper-V Management Suite application. Thus, each installation of Hyper-V Management 

Suite will deploy its own tables based on the computer where Hyper-V Management Suite is 

installed. For example, if you install the software on 3 different computers, single database with 

3 different tables will be created inside the single database and each installed application will 

generate reports separately independent of each other.  
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2. Use a separate database for each instance of the application  

Hyper-V Management Suite creates a single application database in the default data storage 

location used by the SQL Server during application launch. Hyper-V Management Suite uses the 

following naming convention: Hyper-VManagementSuite-<COMPUTERNAME>, where 

COMPUTERNAME is the name of the computer running Hyper-V Management Suite.  

For example, if the computer running Hyper-V Management Suite is ‘CLIENT01’, Hyper-V 

Management Suite creates 'Hyper-V Management Suite-CLIENT01' with data ('Hyper-V 

Management Suite-CLIENT01.mdf') and log (''Hyper-V Management Suite-CLIENT01_log.LDF') 

files stored in the default SQL data folder in the SQL server (for example, C:\Program 

Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data).  

Database cleanup  

Hyper-V Management Suite will delete the application database while uninstalling the Hyper-V 

Management Suite application from the computer. 
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Configure computer enumeration 
________________________________________ 

For enumerating computers in your network automatically, Hyper-V Management Suite uses either 

Computer Browser Service or Active Directory Services. Select an option for enumerating computers in 

your domain as shown below. You may use the Browser service if you have a smaller network, as it may 

take time for the Browser service to respond to data requests on large networks. The advantage of a 

Browser service is that it lists only those computers that are currently active/alive on your network. You 

may use the Active Directory Services option if you have a large network and you need a quicker 

enumeration of computers in your domain. However, this option requires that the domain controller is 

contacted and queried. Therefore, the currently logged on user must have sufficient privileges to connect 

to a domain controller or you may specify alternate domain credentials for a domain controller (see 

configuring the Domain Credentials section in the wizard). 

NOTE: IF you use the Browser service, ensure that NETBIOS over TCP/IP is enabled in both the client and 

the computers that need to be reported on. The Browser service must also be running. 

You can access the Computer Enumeration settings by clicking Tools -> Configuration Settings menu in the 

Hyper-V Management Suite main application window and selecting "Computer Enumeration" node as 

shown below: 
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Configuring domain credentials 
________________________________________ 

Manage alternate credentials for Domain / Directory Servers. The application by default uses the currently 

logged on user context to enumerate Hyper-V Servers and its virtual machines and to collect report data. 

If you want to specify alternate Domain Administrator credentials you may use this option. 

Configuring domain credentials 

 You can access the Domain Credentials settings by selecting the Domain Credentials option in the 

Configuration Settings window. 

 

If you have chosen Active Directory Services under the Computer Enumeration settings, you can launch 

the Hyper-V Management Suite Domain Credentials window within a report window by doing the 

following: 
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1. Select any one of the reports from the Hyper-V Management Suite main application window. For 

example Discovery -> Summary option.  

2. The action will launch the Discovery report window.  

3. In the report window, at the bottom of the treeview click Add Domains button. This action will launch 

the "Domain Credentials" window as shown below. 
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The various operations that can be performed in the Domain Credentials screen are given below:  

Operation Description 

Add To Add a new domain to the list. 

Edit To Edit the properties of a domain in the list. Select a domain and click Edit button. 

Delete To Delete a domain from the list. Select a domain and click Delete button. 

Connect To connect to a domain in the list. Select a domain and click Connect button. 
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Add a domain 
________________________________________ 

You may also add one single domain at a time to the list of domains in the credentials list by using Add 

Domain feature. 

Add a domain to the list 

1. Launch Domain Credentials window.   

2. In the Domain Credentials window, click  Add button to add a domain to the list. 

The New Add domain dialog will be displayed as shown below: 

 

Enter the name of a domain. 
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4. Specify user name and the corresponding password to connect to the specified domain.   

Store the above user credential in Microsoft Windows Stored User Names and Passwords applet - 

Hyper-V Management Suite allows the user to enter different user credentials to connect to the domain. 

Uncheck the checkbox 'Log on using current user' if you like to connect to the domain using a different 

user context.  

Hyper-V Management Suite will store the user credential to connect to domain in the Microsoft Windows 

Stored User Names and Passwords applet / Credential Manager for security reasons. The stored user 

profile is tied to the user context (currently logged on user account) in which the profile is created.  

5. Click OK to add the domain to the Domain Credentials list.  

6. Hyper-V Management Suite will connect to the domain with the newly provided connection parameters 

and add it to the list, upon successful connection to the domain.  
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7. Click Cancel to abort the add process of the domain to the Domain Credentials list.  
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Edit a domain 
________________________________________ 

To Edit a domain in the Domain Credentials, follow the steps given below: 

1. Launch Domain Credentials window.  

2. In the Domain Credentials window, select any row (domain), Click  Edit button to Edit an 

existing domain in the list, as shown below:  

 

3. The domain name cannot be modified during the edit operation.  

4. Specify user name and the corresponding password to connect to the specified domain.  

5. Click OK to save and connect to the domain with the newly provided connection parameters and update 

the domain in the Domain Credentials list.  
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6. Hyper-V Management Suite will connect to the domain with the newly provided connection parameters 

and modify it in the list, upon successful connection to the domain. 

 

7. Click Cancel to retain the existing connection parameters of the domain in the Domain Credentials list. 
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Delete a domain 
________________________________________ 

Perform the following steps to delete a domain: 

Launch Domain Credentials window.   

In the Domain Credentials window, select any row (domain), click  Delete button to delete 

the forest from the Domain Enumeration Manager list. 

 

 

3. An alert message asking for confirmation to delete the domain will be displayed as shown below: 
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4. Click Yes to delete the selected forest. 

5. Click No to abort the delete process of the selected forest. 
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Add domains from forest 
________________________________________ 

In order to connect to a different forest in your Active Directory and configure these domains for 

enumerating computers and generating reports on them, you may use the ‘Add Domains from Forest’ 

feature. 

Add domains from forest to the list 

1. Launch Domain Credentials window.   

2. In the Domain Credentials window, click  to add domains from forest button to add domains in the 

forest to the list.   

3. The Enumerate all Domains in a forest dialog will be displayed as shown below: 

 

Enter the name of a forest. 
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4. Specify user name and the corresponding password to connect to the specified forest.   

Store the above user credential in Microsoft Windows Stored User Names and Passwords applet - Hyper-

V Management Suite allows the user to enter different user credentials to connect to the forest. Uncheck 

the checkbox 'Log on using current user' if you like to connect to the forest using a different user context.  

Hyper-V Management Suite will store the user credential to connect to forest in the Microsoft Windows 

Stored User Names and Passwords applet / Credential Manager for security reasons. The stored user 

profile is tied to the user context (currently logged on user account) in which the profile is created.   

5. Click 'Show Domains' button to add the domains in the specified forest to the list and select the desired 

domains in the list. Click OK to add the selected domains to the Domain Credentials list as shown below. 
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6. Hyper-V Management Suite will add the selected domains to the Domain Credentials list. 
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Configure SMTP Server 
________________________________________ 

Hyper-V Management Suite provides the option to e-mail the reports generated. For e-mailing reports, 

Hyper-V Management Suite requires SMTP Server, From E-mail Address, To E-mail Addresses (recipients 

separated by semicolon) and the e-mail report format. Hyper-V Management Suite maintains a single 

SMTP Server and a From E-mail Address for use by all reports. You can specify a separate set of To e-mail 

addresses (recipients), e-mail report format, subject and body of the message for each reports. 

You can set SMTP Server and From Address by clicking Configuration -> Configuration Settings tab in the 

Hyper-V Management Suite main application window, as shown below: 
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User creation profiles 
________________________________________ 

Hyper-V Management Suite creates a user profile in Windows Stored User Names and Passwords applet 

/ Credential Manager, in order to store the domain user context for enumerating servers using ADSI. 

The stored user profile will be useful for generating reports using Hyper-V Management Suite under the 

following scenarios: 

Using an alternate user account to connect to the domain to retrieve servers using ADSI.  

Providing credentials that have sufficient rights to enumerate shares present in computers within a 

domain.  

The stored user profile persists for all subsequent logon sessions on the same computer where Hyper-V 

Management Suite is installed. The stored user profiles are visible to the application under other logon 

sessions on the same computer. 

The stored user profile created by Hyper-V Management Suite is restricted to the Windows User Profile 

context. If the Windows User Profile is maintained locally, Hyper-V Management Suite stored user profile 

is accessible only by the same user in the same computer. If the user who creates Hyper-V Management 

Suite stored user profile, has a Roaming user account in the enterprise, the Hyper-V Management Suite 

stored user profile can be accessed by the same user in any computer in the Windows enterprise. 

The stored user profile is a generic credential of Windows Stored User Names and Passwords applet / 

Credential Manager and can be used by the application only. The credential information is stored securely 

in an 256 bit encrypted format in Windows Stored User Names and Passwords applet / Credential 

Manager. 

The stored user profile corresponding to the user account will be used by the application in order to 

connect to the domain, if 'Use ADSI' is selected in Hyper-V Management Suite Enumeration Settings. 

Using the Connection Profile dialog shown below, new profile can be created and available profiles can 

be removed from the profiles list. 
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Click Add button to add a new profile and a dialog will appear as shown below: 
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Click Edit button in the Connection Profile dialog to edit available profiles. 

Click Remove button in the Connection Profile dialog to remove available profiles. 
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Hyper-V Reports 
________________________________________ 

About Hyper-V Reports 

How to view Discovery Reports? 

How to view Memory Reports? 

How to view Networking Reports? 

How to view Processor Reports? 

How to view Replication Reports? 

How to view Current Status Reports? 

How to view Snapshot Reports? 

How to view Virtual Hard Disk Reports? 

How to view Integration Services Reports? 

How to view DVD Drive Reports 

How to view All VM Settings Reports? 
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About Hyper-V Reports 
________________________________________ 

Introduction 

Hyper-V Reports Module is used to perform a complete scan for all installed VMs in your network. You 

can perform an automated inventory of VMs and their configuration at regular intervals and keep a 

constant watch on the health of your Hyper-V Servers.Please be aware that the Hyper-V Reports Module 

uses WMI (Windows Management Instrumentation) to collect report data. Hence, all reports require WMI 

to be installed and enabled on the Hyper-V host server and its VMs. For more information refer to 

"Prerequisites and Initial Configuration" section.  

Prerequisites and Initial Configuration 

The Hyper-V Reports Module uses WMI to collect report data. WMI uses DCOM protocol and is affected 

by Windows Firewall and DCOM security settings. In order to generate the reports both Windows Firewall 

and DCOM must be properly configured. Windows Firewall and DCOM, when not properly configured on 

your remote computers, can cause errors such as an "RPC Server Unavailable" error or an "Access is 

denied" error. Also, ensure that the current user context or specified user context, under which the 

application runs, is a local administrator on target computers.  

In order to generate the reports ensure the following settings are set appropriately:  

* Remote Administration setting is enabled on Windows Firewall. By default, Windows Firewall blocks all 

unsolicited incoming traffic except for Group Policy. This is a common issue you might encounter while 

generating the reports. To resolve this issue, you need to enable the remote administration setting on the 

Firewall. For more information about configuring the Windows Firewall connections with a script, see 

http://www.microsoft.com/technet/community/columns/scripts/sg1104.mspx#EJAA. 

* WMI is installed and the Startup Type for WMI service is set to Automatic and the service is running 

under Local System Account. 

* DCOM is enabled and ensure that security settings for DCOM allow remote connections 

1. Run the DCOM Configuration Utility (dcomcnfg.exe) 

2. In the Component Services dialog box, expand Component Services, expand Computers, and then 

right-click My Computer and click Properties 

3. In the My Computer Properties dialog box, click the Default Properties tab  

4. Select Enable Distributed COM on this computer 

5. The Default Authentication Level is set to Connect and the Default Impersonation Level is set to 

Identify in Windows XP and later operating systems. For Windows NT, however, the Default 

Authentication Level is set to Connect and Default Impersonation Level is set to Impersonate  

6. The default DCOM security settings for Access Permissions and Launch and Activation Permissions 

in the COM Security tab in the My Computer Properties dialog includes at least INTERACTIVE, 

SYSTEM and Administrators 

* In Windows XP SP2 and later operating systems the SERVICE account is granted Impersonate a client 

after authentication right under User Rights Assignment under Local Policies 

http://www.microsoft.com/technet/community/columns/scripts/sg1104.mspx%23EJAA
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* The Data Execution Prevention in Windows XP SP2 and Windows 2003 SP1 is enabled for essential 

windows programs only. 

System Info Reports 

The Hyper-V Reports Module provides reports on the following resource categories:  

Discovery 

Memory 

Networking 

Processor 

Replication 

Current Status 

Snapshots 

Virtual Hard Disks 

Integration Services 

DVD Drives 

All VM Settings 
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How to view Discovery Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Discovery information available under each tab as 

listed below.  

Click  tab to view the following information: Host Name, VM Name, VM State, Created Date, 

Notes, Heartbeat, Number of Processors, Guest Operating System, DNS Name. 

 

Click  tab to view the following information:  Host Name, VM Name, Automatic Start 

Action, Automatic Start Delay, Automatic Stop Action, Smart Paging File Location, Snapshot File 

Location. 
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How to view Memory Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Memory information available under each tab as listed 

below. 

Click  tab to view the following information: Host Name, VM Name, State, Startup Memory 

(MB), Dynamic Memory Enabled, Minimum Memory (MB), Maximum Memory (MB), Assigned Memory 

(MB), Memory Demand (MB), Status, Memory Buffer (%), Memory Weight, Status Report as on. 

 

Click  tab to view the following information: 
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How to view Networking Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Networking information available under each tab 

as listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Adapter, Connection, 

Connection Type, IP Address, Status, Status Recorded as on. 

 

Click  tab to view the following information:  Host Name, VM Name, MAC Addess 

Spoofing, DHCP gaurd, Router gaurd, Mirroring Mode,NIC Teaming, Status Recorded as on. 
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How to view Processor Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Processor information available under each tab as 

listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Number of Processor, 

Characteristics, Status, LoadPercentage, Virtual machine reserve (Percentage), Virtual machine 

limit(Percentage), Relative weight, Status Recorded as on. 

 

Click  tab to view the following information: Host Name, VM Name, State, 

MaxProcessorPerNumaNode, MaxMemoryPerNumaNode, MaxNumaNodesPerSocket, Status Recorded 

as on. 
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Click  tab to view the following information:  Host Name, VM Name, State, Number of 

Processor, Number of NUMA nodes, Number of Sockets, Processor Compactibility, Status Recorded as on. 
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44 
 

How to view Replication Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Replication information available under each tab 

as listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Replication Type, 

Replication State, Replication Health, Current Primary Server, Current Replica Server, Last synchronized 

at, Status Recorded as on. 
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How to view Current Status Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Current Status information available under each tab 

as listed below. 

Click  tab to view the following information: Host Name, VM Name, State, CPU Usage (%), 

Memory Usage (MB), Up Time, Replication Health, Currently Logged on User, User Logged on Since, Status 

Recorded as on. 
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Click  tab to view the following information:  
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How to view Snapshots Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Snapshot information available under each tab as 

listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Snapshot Name, 

Creation Time, Snapshot Path, Status Recorded as on. 

 

Click  tab to view the following information:  Host Name, VM Name, Snapshot Name, Startup 

Memory, Dynamic Memory Enabled, Minimum Memory, Maximum Memory, Memory Buffer, Memeory 

Weight, Status Recorded as on. 
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Click  tab to view the following information:  Host Name, VM Name, Snapshot Name, Number 

of Processors, Virtual machine reserve (Percentage), Virtual machine limit (Percentage), Relative weight, 

Status Recorded as on. 
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Click  tab to view the following information:  Host Name, VM Name, Snapshot Name, 

Number of Processors, Virtual machine reserve (Percentage), Virtual machine limit (Percentage),  Relative 

weight, Status Recorded as on. 

 

Click  tab to view the following information:  Host Name, VM Name, Snapshot Name, 

Number of Processors, Virtual machine reserve (Percentage), Virtual machine limit (Percentage),  Relative 

weight, Status Recorded as on. 
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Click  tab to view the following information: Host Name, VM Name, Snapshot Name, Number 

of Processors, Virtual machine reserve (Percentage), Virtual machine limit (Percentage), Relative weight, 

Status Recorded as on. 
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Click  tab to view the following information:  Host Name, VM Name, Snapshot Name, Number 

of Processors, Virtual machine reserve (Percentage), Virtual machine limit (Percentage), Relative weight, 

Status Recorded as on. 
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How to view Virtual Hard Disk Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view Virtual Hard Disks information available under each 

tab as listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Hard Disk Name, 

Format, Type, Location, Maximum Disk Size (GB), Current File Size (GB), Parent Path. 

 

Click  tab to view the following information: VM Name, State, Hard Disk Name, Location, User 

Name, Access Type, Permission, Is Inherited, Status Recorded as on. 

 

Click  tab to view the following information:   
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How to view Integration Services Report? 
________________________________________ 

Click on  under Hyper-V Reports to view Integration Services information available under 

each tab as listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Operating system 

shutdown, Time synchronization, Data Exchange, Heartbeat, Backup (Volume snapshot), Status Recorded 

as on. 

 

 

 



 

55 
 

How to view DVD Drives Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view DVD Drives information available under each tab as 

listed below. 

Click  tab to view the following information: Host Name, VM Name, State, Mounted Media, 

Controller, Location, Status Recorded as on. 
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How to view All VM Settings Reports? 
________________________________________ 

Click on  under Hyper-V Reports to view All VM Settings available under each tab as listed 

below. 
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Additional Features 
________________________________________ 

How to Customize Fields? 

How to Apply Filters? 

How to Refresh Data? 

How to Export data? 

How to E-mail data? 
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How to Customize fields? 
________________________________________ 

Click  for customizing the information. 

 

Click  for selecting all the check boxes. 

Click  for clearing all the check boxes. 

Click  button for confirming the changes. 

Click  button for canceling the operation. 
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How to apply Filters? 
________________________________________ 

Click  for setting filter options. 

The Hyper-V Management Suite Filter window will be displayed. 

 

To set a filter condition, follow these steps. 

1. Click  (Clear All) button and clear the filter. 

2. Choose a field name, an operator and a possible value from the respective dropdown options. 

3. Click  

4. The Add to Filter will change to AND to Filter. The OR to Filter button will be enabled. The selected 

condition will be set as a filter and displayed (as shown below). 
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5. Click OK to apply the filter. 

Note:  

* Use the ,  and  to build enhanced filter 

condition as shown below: 

* (Field A = Value 1 AND Field B = Value 2) OR (Field C = Value 3 AND Field D = Value 4) 

* Use  to remove the parenthesis 

* Use  to delete a selected condition. 
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How to Refresh data? 
________________________________________ 

Refresh the current report data to view the latest information.    

Click   button in the toolbar available in the report window to refresh report data. The 

existing data will be cleared and latest data will be loaded in the report window. 
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How to Export data? 
________________________________________ 

The Export feature helps the user to export report data generated by Hyper-V Management Suite to a file 

using various formats namely HTML/CSV/XLSX. 

Click  for exporting the information in the desired format or select Export option to export 

report data to a file in the desired format. 

 

Specify a file name to export report data to or accept the default file name. Specify the export path and 

select a desired file format. The path refers to the destination location where the output file generated 

should be stored. It can be given using the Browse button. To avoid overwrite existing files, if any, in the 

specified export path, By default, the report will be exported to a time-stamped sub-folder, in the format 

'YYYY-MM-DD HH.MM.SS', under the specified export path. 

In XLSX file format, the information is stored as sheets in Excel file. For each report, a XLSX file will be 

generated. The name of the XLSX file will be the name of the report and is stored in the specified 

destination path if "Export to time-stamped folder" option is cleared. The XLSX file will be stored under a 

sub-folder, of the form YYYY-MM-DD HH.MM.SS, under the specified export path, if "Export to time-

stamped folder" option is set. 

In CSV file format, the information is stored as comma separated values. For each report, a CSV file will 

be generated. The name of the CSV file will be the name of the report and is stored in the specified 

destination path if "Export to time-stamped folder" option is cleared or under a sub-folder, of the form 

YYYY-MM-DD HH.MM.SS, under the specified export path if "Export to time-stamped folder" option is set. 

In HTML file format, the information is stored as a html file. For each report, a HTML file will be generated. 

The name of the HTML file will be the name of the report and is stored in the specified destination path if 

"Export to time-stamped folder" option is cleared or under a sub-folder, of the form YYYY-MM-DD 

HH.MM.SS, under the specified export path if "Export to time-stamped folder" option is set.  
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How to Email data? 
________________________________________ 

Hyper-V Management Suite provides the option to e-mail the reports generated. 

Click  button in the toolbar to e-mail the report to e-mail recipients. E-mail dialog will be 

displayed as shown below: 

 

For e-mailing reports, Hyper-V Management Suite requires SMTP Server, From E-mail Address, To E-mail 

Addresses (recipients separated by semicolon) and the report attachment format.  

Specify SMTP server name, from Address, To address, mail subject, mail content, attachment format and 

option to compress the attachment.  

Click  button to send the report by e-mail to the selected recipients.   
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Check names 

Hyper-V Management Suite provides check name feature to check the existence of corresponding mail-

enabled recipient object in Active Directory. To check name, click   button. If the entered name 

matches with a mail object in the Active directory / its trusted domain, name entered in From address 

textbox will be replaced by the corresponding active directory recipient object. If there is more than one 

match, a dialog which contains matching Active Directory recipients will appear as shown below. You can 

select one or more recipient and click OK. 

 

* To get more information about the listed recipients under Change to, select the name, and then click. 
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If there is no match for the name entered by the user in Active Directory, a dialog will appear as shown 

below: 

 

Select Delete option in the above dialog to remove the recipient name from To address text box. Click 

Cancel button to close this dialog and the unresolved recipient(s) will appear in red color. 
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Address Book 

Hyper-V Management Suite provides Address Book feature to search for any mail enabled recipient object 

(say, person, distribution list, contact, public folder) you want to send a message to. Click   

button and then use the Find Names dialog box to search for the recipient object you want to send a 

message to. (Note that you can't use the Find Names dialog box to search for distribution lists in your 

Contacts folder.) Select the object's name in the list and then click Add recipient to...To. 

 

To get more information about one of the names in the list, such as department or phone number, select 

the name, and then click.  
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Schedule 
________________________________________ 

About Schedule Reports 

Task Manager 

How to Schedule Reports? 
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About Schedule Reports 
________________________________________ 

Hyper-V Management Suite provides a powerful offline report generation feature called Schedule Report. 

Schedule Report allows the user to select multiple reports to be run for several hosts and VMs across the 

enterprise at scheduled intervals. The Schedule Report feature has the ability to export and/or e-mail the 

reports in different file formats.  

Please note the following while using the Schedule Report Wizard: 

A. Scheduled reports will be created as a "task" in Windows Task Scheduler.  

B. The scheduled job will generate and export/email the reports in different file formats (HTML, CSV 

and XLSX) to the desired folder path/printer.  

C. By default, for each task, a sub-folder with the task name will be created under the specified 

export path. All selected Reports will be exported to a time-stamped sub-folder, in the format 

"yyyy-mm-dd hh.mm.ss", under the task name folder. Therefore, the full folder path for all the 

exported reports refers to the following directory: <Export path><Task name><Time stamp>.  

D. A separate file will be created for each report in the desired file format. For example, in the HTML 

file format, each report will be created as a .html file. 

Note: Schedule Report Wizard will help you create and store the settings for a task, which you may view 

or modify later using the Scheduled Tasks Manager. The task will be created with the settings (Schedule 

Type and Run As parameter) provided using the Schedule Report Wizard. A valid password must be 

specified for the Run As parameter of the task. 
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Schedule Task Manager 
________________________________________ 

The Scheduled Tasks Manager allows you to perform the following operations: 

 View summary information for the tasks created  

 View exported files of the task  

 Edit an existing task  

 Delete a task 

View summary information of a task 

The pane on the left hand side in the Scheduled Tasks Manager window lists the tasks maintained in 

Hyper-V Management Suite. To view summary information of a task, select the desired task on the left 

pane. The summary information of the selected task will be displayed in the right pane as shown below: 

 

The task summary includes information about the task information, reports selected, export/e-mail 

settings. 

View exported files 

To view the reports generated and exported by the task, perform either one of the following steps:  

* Select Scheduled Tasks node on the left pane, and then click on the hyperlink in the Exported Files 

column in the right pane for the desired task.  
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  OR 

* Select the desired task on the left pane, and then click on the hyperlink next to Exported Files.  

Edit Task  

1. Select a task from the Scheduled Tasks Manager Window and Click Edit Task.  

2. Perform the steps as in How to Schedule reports? While proceeding through the wizard, you may 

change the settings, add a new report, delete a report, edit a report, change the export path etc.  

3. The new settings will be used when the task runs the next time. 

Delete Task 

To delete a task from the Scheduled Tasks Window, select the task and click Delete Task. The deleted 

task will be removed permanently from the Windows Task Scheduler. 
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How to Schedule Reports? 
________________________________________ 

Select  option under Hyper-V Reports. This will bring up the Schedule Report Wizard. 

Step 1: Report Selection 

 

1. Select the report(s) using the checkboxes to the left of the reports. You may select any number of 

reports to run in a single task.  

2. Click Next to proceed to the next step. 
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Step 2: Host/VM Selection 

 

1. Select the Hosts and VMs for which you wish to run the reports selected in Step 1.  

2. Click Next to proceed to the Next step. 
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Step 3: Delivery Options   

 

1. Change the Export or E-mail settings as necessary.  

2. Use Browse button to change the export path. 

* Click Additional E-mail Settings button to specify optional e-mail settings as shown below. 
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Step 4: Schedule Settings 

 

1. Enter a unique name for the task.  

2. Change the Run as parameter, if necessary and set the password for the specified user.  

3. Change the task schedule settings as required.  

4. Click Next to proceed to the next and final step. 

 

 

 

 

 

 



 

76 
 

 

Step 5: Summary 

 

1. This step displays the summary information of the task.  

2. Click Finish to save the task details.  

3. The task will be added to Windows Scheduled Tasks and will be displayed in the Scheduled Tasks 

Manager Window as shown below: 
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Scan Profiles Manager 
________________________________________ 

About Scan Profiles (Host Computers) 

How to create Scan Profiles (Host Computers)? 

How to manage Scan Profiles (Host Computers)? 

How to apply Scan Profiles (Host Computers)? 
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About Scan Profiles (Host Computers) 
________________________________________ 

You can setup Scan Profiles to scan a subset of host computers in the network and save these profiles for 

repeated use while generating reports (useful for repeatedly scanning and reporting on different subsets 

of host computers).   

 

You can create Scan Profiles in one of the following ways:  

 Selecting specific host computers in the network  

 Selecting specific Windows versions  

 Importing list of host computers from a text file  

 Importing list of IP addresses from a text file  
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How to create Scan Profiles (Host Computers)? 
________________________________________ 

The Scan Profile Dialog allows you to create or edit a Scan Profile. During edit operation, the name of a 

Scan Profile and its type cannot be modified. You can access the Scan Profile Dialog from the Scan Profiles 

Manager. 

Perform the following steps to create a Scan Profile. 

1. Click New button in the Scan Profiles Manager window. The Scan Profile dialog will show up on screen.   

2. Specify a name for the Scan Profile. You must give a unique name for the Scan Profile.   

3. Specify how you want to create the profile by selecting appropriate profile type. You can create Scan 

Profiles in one of the following ways:   

A. Selecting host computers from network 

 

i. Select Select host computers from network option.  

ii. You can type in host computer name, in the format "Domain Name\Computer Name", and then click 

Add button to manually add it to the list. Or you may click Add From button to browse the network and 

select specific computers. 
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B. Selecting specific Windows versions 

 

i. Select Select specific Windows version(s) option.  

ii. Select one or more Windows versions. Only host computers running the selected Windows version will 

be included in the host computer list.  

iii. You may optionally select specific domains, from the list of domains, to include host computers only 

from the selected domains. If you choose not to select any domains, then the Scan Profile includes all 

domains in the network.  

Note: This type of profile is dynamic in nature, in that the list of host computers are prepared at run-time; 

that is at report generation time. 

C. Importing list of host computers from a text file 
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i. Select Import list of host computers from text file option.  

ii. Click browse ("...") button to select a file that contains the list of host computers to be imported.  

iii. In the "Select File" dialog that shows up, select a text (.txt) file, and then click Open.  

iv. Click Import button to import the list of host computers from the selected file. 

Note  

The text file should contain host computer names in the format "Domain Name\Computer Name" (both 

Domain and Computer name should be a NETBIOS name) with each entry in a separate line as shown 

below: 

 

Only valid entries of the form "Domain Name\Computer Name" will be imported, and invalid entries will 

be ignored. Please note that the domain specified will be matched with the domain name to which the 

computer belongs. The computer entry will be ignored either if the domain name does not match or an if 

error occurs retrieving the domain name. To view the list of entries imported, click Verify Imported List 

button. The list of host computer names imported will be displayed as shown below: 
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Changes to the external text file will not automatically be reflected in the Scan Profile. You need to edit 

the Scan Profile and re-import the updated computer list from the file. 

D. Importing list of IP addresses from a text file 

 

i. Select Import list of IP addresses from text file option.  

ii. Click browse ("...") button to select a file that contains the list of IP addresses to be imported.  

iii. In the "Select File" dialog that shows up, select a text (.txt) file, and then click Open.  

iv. Click Import button to import the list of IP addresses from the selected file. 
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Note 

The text file should contain valid IP addresses with each entry in a separate line as shown below: 

 

During the import process each IP address will be translated to a corresponding computer name. Hence, 

only valid entries will be imported. To view the list of entries imported, click Verify Imported List button. 

The list of IP addresses and their corresponding computer names will be displayed as shown below: 

 

Changes to the external text file will not automatically be reflected in the Scan Profile. You need to edit 

the Scan Profile and re-import the updated IP address list from the file. 

4. Click OK to save the Scan Profile for later use.   
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How to Manage Scan Profiles 
________________________________________ 

Click  to launch the Scan Profiles Manager. The Scan Profiles Manager shows the list of Scan 

Profiles available. 

 

The Scan Profiles Manager allows you to perform the following operations: 

 Create a new Scan Profile  

 Edit an existing Scan Profile  

 Delete a Scan Profile  

 Preview the list of computers in a Scan Profile 

Create a new Scan Profile 

1. To create a new Scan Profile click New  

2. Follow the steps as outlined in How to create Scan Profiles? 
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Edit an existing Scan Profile 

1. To edit a Scan Profile click Edit button in the Scan Profiles Manager. The Scan Profile Dialog will appear 

on the screen which will allow you to edit the selected Scan Profile.  

2. During edit operation you can modify the computer list, however, you cannot modify the type of the 

Scan Profile. 

Delete a Scan Profile 

To delete a Scan Profile, select the profile you want to delete, and then click Delete button. The selected 

Scan Profile will be deleted permanently. Please note, that reports associated with the Scan Profile 

deleted may fail to run when generated.   

Preview the list of computers in a Scan Profile 

To preview the list of computers in a Scan Profile, select a Scan Profile, and then click Preview button. The 

computer list will be displayed in a tree view as shown below:   

 

The Preview window shows the list of domains and host computers selected in the Scan Profile if the host 

computer list was either imported or selected from the network. Whereas, if specific Windows versions 

were selected, then only the host computers that match the selected Windows versions will show up. 

Furthermore, if specific domains were associated with the Scan Profile, then only the selected domains 

will show up, otherwise all the domains in the network will show up.   

The Preview window allows you to view what host computers in the network will be included in the profile.   
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How to apply Scan Profiles 
________________________________________ 

You can apply a Scan Profile to one or more reports to restrict the list of host computers during report 

generation. This is especially useful if you want to generate reports for a subset of host computers. 

Apply Scan Profile 

You can apply a Scan Profile by clicking the  button in the report window. The Scan 

Profiles Manager will show up on screen, select a Scan Profile, and then click Apply button to apply the 

selected profile. 

A Scan Profile when applied reloads the tree view, in the left pane in the report window, with the list of 

host computers in the selected Scan Profile. After a Scan Profile is applied, you can select the desired host 

or VM computer in the tree view in the report window to generate the report. Click the Clear button to 

clear the applied profile. This will reload tree view with the list of all domains in the network. 

 

 

References  
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Troubleshooting 

How to uninstall Hyper-V Management Suite? 
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Troubleshooting  
________________________________________ 

If and when a problem arises, please forward the following information to support@vyapin.com to revert 

back to you with a solution. These files will be available where Hyper-V Management Suite is installed. 

Error Log File  

E.g., <Application Data Folder>\Hyper-V Management Suite\HyperVManagementSuiteErrorLog.txt  

Note 

<Application Data Folder> is the common area where Hyper-V Management Suite settings will be stored 

in the machine running Hyper-V Management Suite. The <Application Data Folder> can be found from the 

Help -> About screen. The default path of <Application Data Folder> is as follows:  

Windows 7, Windows 8, Windows 8.1, Windows 2008, Windows Server 2012, Windows Server 2012 R2  - 

C:\Users\Public\Documents  
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How to uninstall Hyper-V Management Suite  
________________________________________ 

When you uninstall Hyper-V Management Suite through Control Panel - Add / Remove Programs applet, 

Windows Installer program will remove only the application files from your machine. But, the application 

related files created by Hyper-V Management Suite remain in the computer. In order to remove Hyper-V 

Management Suite worker files completely, the uninstall wizard provides a set of cleanup options to 

perform the cleanup operation based upon your selection. 

Use this wizard to cleanup the files that are created by Hyper-V Management Suite application selectively 

and uninstall Hyper-V Management Suite completely from the machine. 

1.Launch the uninstall wizard by clicking Start -> Programs -> Hyper-V Management Suite -> Uninstall 

Hyper-V Management Suite.   

The Hyper-V Management Suite Uninstall Wizard dialog will be shown as below: 

 

Click Next to proceed. 

2. Select required cleanup options as shown below: 
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Click Next to proceed. 

3. Confirm the cleanup and/or uninstall process. 
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Click Finish to run cleanup and/or uninstall process. Click Cancel to close the wizard. 

4. Once the file cleanup process is complete, the uninstall wizard will automatically run Windows Installer 

program to remove Hyper-V Management Suite application from the machine. 
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